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Creating	Your	Own	Newspaper	Template	in	Google	Slides:	A	Step-by-Step	Guide	To	create	a	newspaper	template	in	Google	Slides,	follow	these	steps:	Firstly,	go	to	the	File	menu	and	click	on	Page	setup.	Then,	select	Custom	from	the	drop-down	menu	for	page	size.	In	our	case,	we	chose	an	8	x	11	inch	vertical	layout.	Next,	click	on	the	Background
option	in	the	toolbar	and	choose	a	suitable	color	that	resembles	a	newspaper	background.	You	can	also	create	your	own	custom	color	by	selecting	the	Colors	option	and	experimenting	with	different	shades	of	gray.	Once	you	have	set	up	your	background,	it's	time	to	add	the	columns	for	your	newspaper.	Create	smaller	text	boxes	for	headlines	and
article	summaries	in	a	layout	that	suits	your	needs.	Change	the	font	to	a	serif	font,	such	as	Times	New	Roman	or	Georgia,	and	align	the	text	to	Justify.	To	give	your	newspaper	a	more	traditional	feel,	use	horizontal	lines	or	boxes	to	separate	sections	and	create	a	structured	layout.	You	can	also	use	the	draw	feature	to	be	more	creative	with	your	design.
Finally,	add	images	and	captions	to	make	your	newspaper	visually	appealing.	Use	a	variety	of	image	styles,	such	as	photographs	or	illustrations,	to	enhance	the	visual	interest.	By	following	these	steps,	you	can	create	a	professional-looking	newspaper	template	in	Google	Slides	that	is	perfect	for	sharing	news,	current	events,	or	even	student	reports.
We’ve	shown	you	just	how	to	do	this,	and	as	a	bonus,	we’ve	also	provided	you	with	our	own	templates.	newspaper	business	is	still	going	strong,	and	thanks	to	technology,	it’s	never	been	easier	to	make	your	own	newspaper.	We’ve	already	shown	you	just	how	easy	it	is	with	our	step-by-step	guide.	Skip	right	to	the	content	and	publishing	of	your
newspaper	thanks	to	our	Google	Slides	newspaper	templates.	Now	that	you	have	the	perfect	newspaper	template	for	Google	Slides,	just	don’t	forget	to	add	the	crossword.	If	you	found	these	templates	useful,	make	sure	you	check	out	our	premium	selection	too.	Just	remember	to	use	the	code	SSP	to	save	50%	at	checkout.	Get	Premium	Templates
Related:	Did	you	know	that	first	Newspaper	was	published	in	Rome	in	59	BC?	That	was	way	before	the	printing	press	was	even	invented.	Even	though	there	are	now	plenty	of	other	media	formats,	need	to	keep	up	with	events	and	daily	gossip	will	ensure	that	newspapers	always	remain	relevant.	And	now	you	can	make	your	own	Newspaper	online	in
Google	Slides.	We’ll	take	you	through	how	to	make	a	Newspaper	Slide	in	Google	Slides,	and	we’ve	also	included	couple	of	templates	that	you	can	use.	Read	on	to	find	the	perfect	newspaper	template	for	Google	Slides.	How	To	Do	A	Newspaper	Format	on	Google	Slides	To	do	a	newspaper	format	on	Google	Slide,	follow	following	steps:	Step	1:	Change
the	Page	Settings	Go	to	File	>	Page	setup	Click	the	drop-down	for	the	size,	then	Custom	Change	the	paper	size	appropriately,	adding	custom	size	you	want	to	make	slides	vertical.	In	our	case,	we	chose	8”	by	11”.	Step	2:	Choose	a	suitable	background	color.	Click	Background	in	the	toolbar.	Click	the	drop-down	for	color.	Choose	a	color	or	create	your
own	custom	color.	Click	Add	to	theme	to	apply	it	to	all	the	Slides.	Step	3:	Create	the	Newspaper	Header	Remove	textboxes	present	electing	them	and	clicking	backspace.	Click	textbox	icon	and	create	large	text	box	at	top	of	slide	for	newspaper’s	masthead	or	logo.	Resize	it	and	use	bold	font	that	stands	out	and	reflects	style	of	a	newspaper.	Step	4:
Add	Your	Columns	Create	smaller	text	boxes	for	headlines	and	article	summaries	in	layout	you	want	your	columns	to	appear.	Change	font	to	serif	font	for	body	text	to	create	traditional	newspaper	feel.	Change	alignment	to	Justify	and	change	indentation	of	text.	Step	5:	Add	Images	and	Captions	You	can	use	variety	image	styles,	such	as	photographs	or
illustrations,	to	add	visual	interest.	To	add	an	image,	click	image	icon	in	toolbar.	Upload	your	image	Resize	and	reposition	it.	Step	6:	Add	Design	Elements	Use	horizontal	lines	or	boxes	to	separate	sections	of	your	newspaper	and	create	structured	layout.	You	can	use	draw	feature	in	Google	Slides	to	be	more	creative	with	your	design.	These	are	steps
to	create	a	Newspaper	template	in	Google	Slides.	Let’s	look	at	some	of	our	Google	presentation	newspaper	templates.	Newspaper	Slides	Templates	Old	Paper	Google	Slides	Theme	Access	Template	This	template	has	old-timey	Google	Slides	theme	with	grey-and-white	color	scheme	that	gives	it	aged	look.	It	has	three	text	columns	and	section	with	dark
grey	background	for	highlight	story.	This	template	comes	in	3	slides	with	varying	layouts	to	experiment	with	but	maintains	theme	of	template.	Modern	Newspaper	Template	Access	Template	The	modern	newspaper	template	is	popular	newspaper	Google	Slides	theme	with	part	of	heading	in	bold	red	that	pops	out	against	rest	of	black-and-white	format.
It	has	3	slides,	each	with	different	layout	following	same	theme.	Vintage	Newspaper	Template	for	Google	Slides	Access	Template	The	vintage	newspaper	template	reminiscent	of	earlier	newspapers	with	bold	heading	font	and	large	headers.	It	has	greyish-brown	background	color,	and	it’s	divided	into	three	text	columns.	The	template	comes	with	3
slides	with	different	layouts	in	same	vintage	Google	Slides	background	theme.	Why	Use	Our	Templates?	Here	are	couple	benefits	of	using	our	newspaper	style	templates:	Our	pre-made	Slide	templates	are	convenient	to	use	and	will	save	you	time	and	effort	it	takes	to	make	your	own	newspaper	slides,	not	mention	stress	of	trying	to	figure	out	layout.
You	can	publish	papers	much	faster	thanks	to	our	templates.	The	templates	in	this	article	are	easy	to	customize	with	clear	layout	that	you	can	move	around	simply	by	clicking	and	dragging	different	components	on	slide.	You	can	collaborate	easily	with	other	writers	and	editors	on	newspaper	using	Google	Slides	collaborative	feature	and	view	changes
being	made	simultaneously.	All	you	have	to	do	is	share	slide	and	set	permissions	for	other	users.	Google	Slides	also	automatically	saves	your	newspaper	in	drive	and	also	saves	changes	made	so	that	you	can	easily	backtrack	and	view	changes	made.	Our	designs	are	professional	and	aesthetic,	with	industry-standard	newspaper	layouts	and	formats.	Our
templates	are	versatile	and	can	be	adapted	for	any	use.	You	can	also	convert	our	newspaper	template	to	PowerPoint	if	prefer.	A	couple	of	our	templates	are	also	free	to	use,	so	you	can	save	some	costs	buying	professional	newspaper	template.	Frequently	Asked	Questions	What	Is	A	Newspaper	Font	on	Google	Slides?	The	best	newspaper	fonts	for	your
Newspaper	on	Google	Slides	are	serif	fonts	characterized	by	small	lines	or	flourishing	at	ends	of	each	letter.	Other	really	good	newspaper	fonts	include	Times	New	Roman,	Georgia,	and	Garamond.	These	fonts	are	often	used	because	of	their	readability	and	classic	look,	which	can	lend	Unfortunately,	there	isn't	any	newspaper	template	directly
available	on	Google	Slides.	However,	you	can	create	your	own	unique	newspaper-style	presentation	using	text	boxes,	images,	and	other	design	elements.	Our	guides	will	walk	you	through	this	process,	including	a	step-by-step	guide	to	help	with	content	creation	and	publishing.	With	our	custom	templates,	you'll	be	able	to	skip	over	the	initial	setup	and
get	started	right	away.	Don't	forget	to	add	the	crossword	puzzle	element	to	complete	your	presentation.	###ARTICLEUsing	newspaper-style	Google	Slides	templates	can	be	an	effective	way	to	create	visually	appealing	and	informative	presentations.	With	many	free	templates	available	online,	it's	easier	than	ever	to	simplify	your	design	process.	Here
are	some	of	the	main	advantages	of	using	pre-made	newspaper	templates:	Save	time	-	The	layout	is	already	designed,	so	you	can	skip	this	tedious	step	and	focus	on	the	content.	Look	professional	-	Carefully	crafted	templates	have	a	polished,	print-style	look	that	helps	create	a	great	impression.	Easy	to	edit	-	Simply	insert	your	information	into	text
boxes	and	image	holders.	Customizable	sections	-	Most	templates	have	areas	for	headlines,	articles,	photos,	quotes,	etc.	Creative	design	options	-	Choose	from	various	stylish	format	choices.	Using	newspaper-style	Google	Slides	templates	allows	anyone	to	make	presentations	that	look	like	they	were	created	by	a	professional	graphic	designer.	This
helps	better	communicate	your	ideas	to	audiences.	To	customize	a	free	newspaper	template,	follow	these	simple	instructions:	Search	online	for	"free	newspaper	template	Google	Slides"	and	browse	the	selection.	Consider	different	styles	based	on	your	topic	and	preferences.	For	example,	an	old-fashioned	newspaper	style	could	work	well	for	a	history
presentation	while	something	more	modern	may	suit	a	tech	or	business	pitch.	Once	you've	found	the	perfect	template,	open	it	in	Google	Slides	by	clicking	the	link	or	clicking	"Use	Template"	if	available.	Make	a	copy	to	edit,	delete	any	sample	images,	and	insert	your	own	relevant	photos	and	graphics.	Adjust	sizes	as	needed,	type	or	paste	text	into	the
provided	headline,	subheading,	and	text	boxes,	edit	font	styles	if	desired,	rearrange,	add,	or	delete	text	boxes	if	you	want	to	modify	the	format,	stick	to	a	logical	organization,	and	alter	the	color	palette	to	better	suit	your	brand	or	topic.	By	following	these	steps	and	implementing	additional	tips	for	sleek	and	compelling	presentations,	such	as	using	slide
transitions	and	animations	in	moderation,	maintaining	a	consistent	font	family	throughout,	utilizing	white	space	for	cleanliness,	including	relevant	charts	and	graphs,	and	more,	you	can	transform	newspaper	templates	into	customized	presentations	that	effectively	convey	your	ideas	while	looking	professionally	designed.	Free	Google	Slides	Newspaper
Templates	Save	Time,	Look	Professional	and	Boost	Engagement	Get	ready	to	create	visually	appealing	presentations	with	our	collection	of	free	Google	Slides	newspaper	templates.	Festival	newspaper	is	a	crucial	component	of	any	successful	festival,	providing	an	essential	platform	for	sharing	news,	updates,	and	information	with	attendees.	For	local
news	outlets	and	community	bulletins,	our	Yellow	One	List	Newspaper	template	offers	a	free,	customizable	design	that's	perfect	for	creating	engaging	content.	We	also	have	the	Strict	Political	Newspaper,	which	provides	in-depth	analysis	through	its	structured	and	no-nonsense	design.	For	those	interested	in	sports,	our	Beautiful	Sports	Newspaper
showcases	dynamic	visuals	alongside	compelling	sports	coverage.	Alternatively,	you	can	opt	for	our	Minimal	Underground	Newspaper	template,	featuring	a	unique	and	custom	design	that	eliminates	the	need	to	select	fonts,	structure,	and	background	colors.	If	you're	looking	for	something	more	modern,	our	Black	and	White	Newspaper	design	is	an
excellent	option,	providing	a	simple	yet	elegant	look	without	requiring	extensive	layout	adjustments.	If	you	want	to	share	content	about	your	region,	our	Canada	Newspaper	design	offers	a	great	way	to	showcase	local	views,	snowy	winters,	and	big	cities.	We	also	have	several	patriotic	American	History	Newspaper	templates	available,	ideal	for	school
projects	and	multi-circulation	publications.	Our	Modest	Obituary	Newspaper	template	is	another	useful	option	for	personal	or	business	needs.	Finally,	if	you're	creating	your	first	newspaper,	our	vintage	Olden	Days	Newspaper	design	is	a	great	starting	point	for	any	topic.	Interestingly,	the	concept	of	newspapers	dates	back	to	ancient	Rome	in	59	BC,
long	before	the	invention	of	the	printing	press.	Despite	the	rise	of	modern	media	formats,	newspapers	will	continue	to	remain	relevant	due	to	their	ability	to	keep	up	with	events	and	daily	gossip.	To	create	your	own	newspaper	using	Google	Slides,	follow	our	step-by-step	guide:	first,	change	the	page	settings	by	selecting	a	custom	size;	next,	choose	a
suitable	background	color;	then,	create	a	newspaper	header	by	adding	a	large	text	box;	after	that,	add	columns	for	headlines	and	article	summaries;	use	images	with	captions	to	enhance	visual	interest;	and	finally,	incorporate	design	elements	like	horizontal	lines	or	boxes	to	separate	sections.	We	offer	several	Google	Slides	Newspaper	templates,
including	Old	Paper,	Modern	Newspaper,	and	Vintage	Newspaper,	each	providing	a	unique	look	and	feel.	By	using	our	templates,	you	can	save	time	and	effort	while	creating	your	newspaper,	as	they're	easy	to	customize	and	collaborate	on	with	others	in	real-time.	Our	templates	are	designed	to	provide	professional-looking	results,	with	features	like
standard	newspaper	layouts	and	formats.	We	also	offer	versatility	in	our	templates,	allowing	you	to	adapt	them	for	various	purposes.	Additionally,	some	of	our	templates	are	free	to	use,	which	can	help	you	save	costs	when	purchasing	a	premium	template.	When	using	Google	Slides,	you	might	be	wondering	if	there's	a	newspaper	template	available.
Unfortunately,	you	won't	find	any	pre-made	templates	in	the	Google	Slides	template	gallery.	However,	you	can	create	your	own	newspaper-style	presentation	by	utilizing	text	boxes,	images,	and	design	elements.	If	you're	interested	in	creating	a	custom	newspaper	template	in	Google	Slides,	here	are	some	steps	to	follow:	First,	adjust	the	slide
dimensions	to	match	standard	newspaper	sizes,	such	as	11	x	17	inches.	Next,	choose	a	layout	that	suits	your	needs,	considering	traditional	newspaper	formats	with	multiple	columns	and	headlines.	You	can	divide	your	slide	into	columns	using	guides,	which	can	be	added	by	right-clicking	on	the	slide.	Text	boxes	are	essential	for	organizing	articles,	so
draw	one	in	each	column	and	adjust	the	font	size	and	style	to	resemble	classic	newspaper	fonts	like	Times	New	Roman	or	Georgia.	Don't	forget	to	add	images	that	complement	your	articles,	and	consider	adding	a	border	around	them	for	a	more	polished	look.	Headlines	should	be	bold	and	eye-catching,	with	separate	text	boxes	above	each	article.
Format	the	headline	with	a	larger	font	size,	bold	text,	and	possibly	a	different	font	color.	For	subheadings,	use	a	slightly	smaller	font	size	than	your	headline	but	keep	it	bold	to	maintain	the	hierarchical	structure	of	the	newspaper	layout.	Once	you've	added	articles,	images,	and	headlines,	polish	the	design	with	some	final	touches.	Consider	adding	a
newspaper	header	at	the	top	of	the	slide	with	your	newspaper's	name	and	date.	Use	Insert	>	Word	art	for	a	stylized	title,	and	align	your	text	and	images	properly	to	ensure	a	clean,	professional	look.	Finally,	save	and	share	your	work	by	downloading	it	as	a	PDF	or	sharing	it	directly	via	Google	Slides.can	also	give	your	Google	Slides	presentation	an
authentic	feel,	similar	to	editorials,	classifieds,	and	weather	forecasts.	Absolutely,	you	can	print	your	Google	Slides	newspaper	with	ease,	by	going	to	File	>	Print,	adjusting	the	settings,	and	printing	it	directly.	It	depends	on	whether	you	need	more	flexibility	in	terms	of	layout	and	design,	making	Google	Slides	a	better	choice	for	creating	newspapers.
On	the	other	hand,	Google	Docs	is	more	suitable	for	longer	text-based	documents	with	fewer	design	elements.	Last	updated:	15.09.2024	Newspaper	Templates	by	format	Google	Docs	(60)	Google	Slides	(6)	All	formats	To	create	an	eye-catching	newspaper-style	presentation,	you	can	use	the	Daily	News	Template	for	Google	Slides,	which	offers	a	sleek
and	professional	design	ideal	for	displaying	news,	announcements	or	reports	in	a	visually	appealing	layout.	This	template	is	also	suitable	for	themed	events,	fan	creations	or	creative	projects.	You	can	also	bring	the	magic	of	the	wizarding	world	to	life	with	the	Daily	Prophet	Newspaper	Template	for	Google	Slides,	perfect	for	themed	events,	fan
creations	or	creative	projects.	This	template	allows	you	to	customize	headlines,	articles	and	visuals	to	recreate	the	look	of	the	iconic	wizard	newspaper.	If	you	need	a	streamlined	way	to	create	classified	ads,	you	can	use	the	Newspaper	Classified	Ad	Templates	for	Google	Slides,	which	allow	you	to	design	professional	clear	ads	for	job	postings,	real
estate	listings	or	community	announcements.	You	can	also	capture	a	vintage	look	with	the	Old	Newspaper	Template	for	Google	Slides,	perfect	for	historical	presentations,	themed	events	or	creative	projects.	Additionally,	the	Vintage	Newspaper	Template	for	Google	Slides	offers	an	elegant	retro	look	perfect	for	showcasing	historical	information,
creative	projects	or	themed	events.	Lastly,	you	can	create	a	professional-looking	newspaper-style	presentation	with	the	Newspaper	Template	for	Google	Slides,	which	is	versatile	and	suitable	for	delivering	news	updates,	reports	or	creative	projects	in	a	realistic	newspaper	format.
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